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PATTERN OF TESTING 

(1) The test shall be online, multiple choice type 
(2) Total questions shall be 80, carrying 1 marks each 
(3) Indicative allocation of 80 marks based on syllabus is as follows: 

(a) Computer fundamentals and windows – 5Marks 
(b) Word Processing-MS Word – 20Marks 
(c) Spread Sheet- MS Excel – 20 Marks 
(d) Computer communications Internet and E-Mail – 20Marks 
(e) Nudi Kannada software in word processing – 10 Marks 
(f) Power Point – 5Marks 

NUMBER OF PAPERS 

(1) There shall be one paper combining both theory and practical configuration 
questions 

(2) The questions paper shall be in both English & Kannada Candidate can opt any 
of the   languages 

COMPUTER LITERACY TEST 
SYLLABUS and SHORT NOTES 

Maximum Marks: 80                                                             Time: 90minutes 

1. Introduction to Computer:                                  5 Marks 
(a) What is Computer 

"An electronic device which is   capable  

of   receiving  information  (data)  in   a  

particular  form  and  of   performing  a  

sequence  of  operations in  accordance  

with  a  predetermined  but variable set  

of procedural instructions (program) to 

produce a result in the form of information or signals. " 
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Charles Babbage is called the "Grand Father" of the computer. The First mechanical 
computer designed by Charles Babbage was called Analytical Engine. It uses read-
only memory in the form of punch cards. 

Computer is an advanced electronic device that takes raw data as input from the user 
and processes these data under the control of set of instructions (called program) and 
gives the result (output) and saves output for the future use. It can process both 
numerical and non-numerical (arithmetic and logical) calculations. 

(b) Broad categories of Computer 

Computers differ based on their data processing abilities. They are classified according 
to purpose, data handling and functionality. 

According to functionality, Compuers are classified as: 

• Analog Computer: A Computer that represents numbers by some continuously 
variable physical quantity, whose variations mimic the properties of some system 
being modeled. 

• Personal computer: A Personal Computer is a computer small and low cost. The 
term "personal computer" is used to describe desktop computers (desktops). 

• Workstation: A terminal or desktop computer in a network. In this context, 
workstation is just a generic term for a user's machine (client machine) in contrast to 
a "server" or "mainframe." 

• Minicomputer: A minicomputer isn't very mini. At least, not in the way most of 
us think of mini. You know how big your personal Computer is and its related family. 

• Mainframe: It refers to the kind of large computer that runs an entire corporation. 

• Supercomputer: Itis the biggest, fastest, and most expensive computers on earth. 
(c) Language of computer  

A vocabulary and set of grammatical rules for instructing a computer to perform 
specific tasks. The term programming language usually refers to high-level languages, 
such as BASIC, C, C++, COBOL, FORTRAN, Ada, and Pascal. 
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(d) Basic application of Computer 
Computers are being used almost every walk of life. 
Office Management : Almost every organisation( business or non-business) are 
moving towards making paper-less office so that computers are widely used today. 
Internet: It is a network of computers in the world. You can browse through much 
more information than you could do in a library. That is because computers can store 
enormous amounts of information. You also have very fast and convenient access to 
information. Through E-Mail you can communicate with a person sitting thousands of 
miles away in seconds. There is chat software that enables one to chat with another 
person on a real time basis. Video conferencing tools are becoming readily available to 
the common man. 
Digital video or audio composition: Audio or video composition and editing have 
been made much easier by computers. It no longer costs thousands of dollars of 
equipment to compose music or make a film. Graphics engineers can use computers 
to generate short or full length films or even to create three dimensional models. 
Anybody owning a computer can now enter the field of media production. Special 
effects in science fiction and action movies are created using computers. 
Desktop publishing: With desktop publishing, you can create page layout s for 
entire books on your personal computer. 
Computers in Medicine: You can diagnose diseases. You can learn the cures. 
Software is used in magnetic resonance imaging to examine the internal organs of the 
human body. Software is used for performing surg ery. Computers are used to store 
patient data. 
Mathematical Calculations: Thanks to computers, which have computing speeds 
of over a million calculations per second we can perform the biggest of mathematical 
calculations. 
Banks: All financial transactions are done by computer software. They provide 
security, speed and convenience. 
Travel: One can book air tickets or railway tickets and make hotel reservations online. 
It reduced the time wastage and travel time for everyone. 
Telecommunications: Softwareis widely used here. Also all mobile phones have 
software embedded in them for maintaining customer detailsand also sending 
message, audio and video through the mobile software.Now a day's internet is 
available in the mobile phone itself. 
Defence: There is software embedded in almost every weapon. Software is used for 
controlling the flight and targeting in ballistic missiles. Software is used to control 
access to atomic bombs. 
E-Learning: Instead of a book it is easier to learn from E-learning software.It not 
only contains text also contain image and animation so it is very easy to understand 
every thing. 
Gambling: We can gamble online instead of going to a casino. 
Examinations: We can give online exams and get instant results. You can check your 
examination results online. 
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Computers in Business: Shops and supermarkets use software, which calculate the 
bills. Taxes can be calculated and paid online. Accounting is done using computers. 
One can predict future trends of business using artificial intelligence software. 
Software is used in major stock markets. One can do trading online. There are fully 
automated factories running on software. 
Certificates: Different types of certificates can be generated. It is very easy to create 
and change layouts. 
ATM machines: The computer software authenticates the user and dispenses cash. 
Marriage: There are matrimonial sites through which one can search for a suitable 
groom or bride. 
News: There are many websites through which you can read the latest or old news. 
Classmates: There are many alumni websites through which you can regain contact 
with your classmates. 
Robotics: Robots are controlled by software. 
Washing Machines: They operate using software. 
Microwave Oven: They are operated by software. 
Planning and Scheduling: Software can be used to store contact information, 
generating plans, scheduling appointments and deadlines. 
Plagiarism: Software can examine content for plagiarism. 
Greeting Cards: You can send and receive greetings pertaining to different 
occasions. 
Sports: Software is used for making umpiring decisions. There are simulation 
software using which a sportsperson can practice his skills. Computers are also to 
identify flaws in technique. 
Aeroplanes: Pilots train on software, which simulates flying. 
Weather analysis: Supercomputers are used to analyze and predict weather. 
 
(e) Components of Computer 
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Central process unit(CPU) 
CPU itself has following three components. 

 Memory or Storage Unit 
 Control Unit 
 ALU(Arithmetic Logic Unit) 

Control Unit : This unit of CPU directs the entire computer 
system  to  carry out stored  program  instructions. This   unit  
controls the operations of all parts of computer  but does  not  
carry out  any  actual  data processing operations. It manages  
and  coordinates  all  the  units of the computer.It obtains the  
instructions from the memory, interprets them, and directs the operation of the 
computer. The control unit must communicate with both the arithmetic logic unit and 
main memory.It also communicates with Input/Output devices for transfer of data or 
results from storage.It does not process or store data. 
CPU consists of two main parts: The control unit and the arithmetic / logic unit (ALU). 
The former controls the flow of data between the CPU and memory, while the latter 
performs arithmetic and logical operations on data 
ALU(Arithmetic Logic Unit): The arithmetic logic unit executes arithmetic and 
logical operations. Arithmetic operations include addition, subtration, multiplication 
and division. All complex operations are done by making repetitive use of above 
operations.The logical operation include compare numbers, letters and special 
characters using logic functions such as AND, OR and NOT. 

How CPU communicate with other units while processing 

 The program and the necessary data are entered into the Computer system from 
an input device, and are stored in main memory where they can be accessed as 
needed. 

 Now, the CPU retrieves the instructions from the main memory, one by one, 
and decodes each instruction to determine what operation to be performed. 

 When required by instruction, the CPU also retrieves the necessary data from 
main memory. 

 The CPU then performs the operation required by the instruction, which might 
be arithmetic or logical operation. As each instruction is performed, the results 
are either temporarily saved by the CPU or are stored in main memory. 

 The processing cycle (retrieve instruction, decode and execute instruction, save 
results) is repeated until all the program instructions have been carried out by 
the CPU. The final results are then either stored in main memory, or are sent to 
an output device such as a printer. 
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Input and output devices 

Input unit 
This  unit  contains  devices  with   the help 
of  which  we  enter   data   into   computer. 
This  unit   makes  link  between  user  and  
computer. The  input devices translate  the 
information into the form understandable 
by  computer.  Keyboard  and  mouse    are  
two basic devices used for giving data or  
instruction to computer. 

Output Unit 

The output unit is used to present soft and hardcopy of information. 

 

 

 

 

 

 

Computer memory 

Computer memory is any physical device capable of storing information temporarily 
or permanently. Computer memory is used for storing your files on the computer. 
Without computer memory, you would't be able to save any files. 
Three types of Memory : 

 Cache memory 
 Primary memory/main memory 
 Secondary memory 

Cache memory 
The cache is a small amount of  high-speed  
memory, usually with a memory cycle time  
comparable  to  the  time  required  by   the  
CPU  to  fetch one instruction. The cache is 
Usually   filled  from  main  memory   when 
instructions  or  data  are  fetched  into  the 
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CPU. Often the main memory will supply a wider data word to the cache than the CPU 
requires, to fill the cache more rapidly. 
Primary Memory / Main Memory 
Primary memory is where information is stored after it is first obtained. The primary 
memory is also referred to as short-term memory. Information sent to primary 
memory storage is deciphered and either discarded or retained for later retrieval. 
Although the information can be stored for a time in the primary memory, it is subject 
to interference and information can be easily forgotten. Over time, information decays 
and is lost from the primary memory storage. 
SECONDARY MEMORY 
Secondary memory is where programs and data are kept on a long-term basis. 
Common secondary storage devices are the hard disk and optical disks. secondary 
memory include disc drives for compact discs (CDs) or digital versatile discs (DVDs), 
as well as removable flash memory. 
Concept of hardware and software 

Hardware 
Hardware refers to the physical elements of a computer. This is also sometime called 
the machinery or the equipment of the computer. Examples of hardware in a computer 
are the keyboard, the monitor, the mouse and the processing unit. 
software 
Programs namely the list of instructions to be executed by Computer is known as the 
software of the Computer. There are different  types of software depending on the 
requirement of user or Computers.  

(f) Representation of data concepts of data processing 

Definition of data 
Basic component of Computer like CPU, RAM etc are transistors. These are made of a 
number of Integrated circuits (ICs), which contain transistors. These transistors set 
like a two-way switch which can be either on or off. These transistors have just two 
operating states; either on or off. When a transistor is switched on, it is said to 
represent the value 1. Conversely, when the transistor is switched off, it is said to 
represent the value 0. The values 0 and 1 are the only two digits with which Computer 
works. 

Bits and Bytes 

The term Bit is an acronym for Binary digit. The bit is the smallest piece of information 
that the Computer can work with. The values 0 and 1 are called Bits. Bits are grouped 
together to form a larger chunk of information called a Byte. A byte consists of eight 
bits that the Computer stores and processes as a single entry. A byte represents one 
character of data (either a letter of the alphabet, decimal digit, or symbol). The 
Computer can store individual bytes in its memory and later retrieve them. 
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Representing Data in Computer 
1Byte -  8Bits 
1Kilobyte -1024 Bytes 
1Megabyte -1024 Kilobytes 
1 Gigabyte - 1024 Terabyte 
Basic data types 
Data types are used within type systems, which offer various ways of defining, 
implementing and using them. Different type systems ensure varying degrees of type 
safety. 
Almost all programming languages explicitly include the notion of data type, though 
different languages may use different terminology. Common data types include: 
 integers, 
 booleans, 
 characters, 
 floating-point numbers, 
 alphanumeric strings. 
Storage of data as files 
Computer data storage, often called storage or memory, is a technology 
consisting of computer components and recording media used to retain digital data. It 
is a core function and fundamental component of computers. 

The  central   processing   unit   (CPU) 

of   a  computer  is  what  manipulates  

data    by   performing   computations. 

In  practice,   almost  all      computers 

use  a  storage  hierarchy,   which puts 

fast but expensive   and small  storage  

options close  to   the  CPU and slower  

but larger and cheaper options farther 

away.  Generally    the    fast    volatile  

technologies   (which  lose  data when 

off power) are referred to as "memory", 

while  slower  persistent  technologies  

are referred to  as "storage";  however,  

"memory" is sometimes also used when  

referring to persistent storage.  
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Data Processing 
Computer data processing is any process that uses a computer program to enter data 
and summaries, analyse or otherwise convert data into usable information. The 
process may be automated and run on a computer. It involves recording, analyzing, 
sorting, summarizing, calculating, disseminating and storing data. 

 

 

 

 

 

 

 

 

 

2. Introduction to windows and windows concepts- 
(a) What is an operating system and basics of window 

An operating system (OS) is software that manages computer hardware and 
software resources and provides common services for computer programs. The 
operating system is an essential component of the system software in a computer 
system. Application programs usually require an operating system to function. 

Microsoft Windows (or simply Windows) is a metafamily of graphical operating 
systems developed, marketed, and sold by Microsoft. It consists of several families of 
operating systems, each of which cater to a certain sector of the computing industry. 
(b) The user interface 

Using mouse and moving Icons on the screen 

On this screen you should see a list of all your apps on the left, a picture of the first 
home screen to the right, and underneath the screen, a list of all of your other screens. 
To rearrange your icons, simply click on one of them with your mouse and move it to 
the desired location on the selected screen in iTunes. If you wish to rearrange icons on 
different screens, just click on the home screen you want to manage to view it and its 
icons. 
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Moving an icon from one home screen to another is just as easy. Simply drag an icon 
you wish to move to another home screen and then place it where you want to on that 
screen 

 

 

 

 

 

 

 

 

The my Computer Icon 

You may already have some shortcuts on your desktop that point to locations on your 
hard drive you will frequently use with Windows Explorer, such as My Computer and 
My Documents. 

 

 

 

 

 

 

 

My Computer shows you a list of all the drives installed on your system, including 
floppy drives and USB drives. The drive on which Windows is installed is usually 
displayed as the C: drive when you double-click on My Computer to open it using 
Windows Explorer. 
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The Recycle Bin 

  

  

 

 

 

 

Status bar, Start Menu 

The Status Bar: the bottom portion  

Of the  Explorer   window   displays  

Information  about  the  folder  you  

have open,  such  as the number  of 

objects  (  the  number  of  files  and 

subfolders in that folder) and the size. 

Running as application 

 

 

 

 

 

 

How to find what is running on a Windows computer 

Windows Task Manager 
The Microsoft Windows Task Manager is a general, quick, and easy method of seeing 

what is running on the computer. 

Tip: You can access the Task Manager by pressing Ctrl + Alt + Del on your keyboard, 

then select Task Manager. You can also right-click with your mouse on the 

Windows Taskbar and select Task Manager. 
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As you can see in the picture below, the Windows Task Manager opens with the 

Applications tab selected, displaying the applications currently open and running on 

the computer. From here, you can end any application that may not be responding or 

can't be closed by normal means (i.e. clicking the X in the upper right corner of the 

application window) by selecting the application and clicking the End Task button. 
 

 

 

 

 

 

 

 

 

 

Clicking on the Processes tab displays the applications that are running, as well as all 
Windows processes that are affiliated with any installed programs, drivers, and 
hardware. You can also identify what processes are consuming your resources by 
clicking on "CPU" or "Mem Usage" (may also be titled "Memory") column headers to 
sort by highest to lowest. 
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Windows Explorer Viewing of file, Folders and Directories 

Windows Explorer is the file management application in Windows. Windows Explorer 
can be used to navigate your hard drive and display the contents of the folders and 
subfolders you use to organize your files on your hard drive. Windows Explorer is 
automatically launched any time you open a folder in Windows XP.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can also right-click on a folder and select Explore to open that folder using 
Windows Explorer. 

 

 

 

 

 

 

 

 

 



COMPUTER LITERACY TEST 14 

 

 Yakub Koyyur,GHS Nada,Belthangady Taluk,D.K.-574214 Ph:9008983286 14 

Creating and Renaming files and folders 

Creating a New Folder 

To create a new folder, right-click the mouse in a blank area and from the pop-up 
menu, select New, and then choose Folder. While its name (initially “untitled 
folder”) is highlighted, type a new name for the folder and press Enter. (If you 
accidentally deselect the name before changing it, follow the instructions 
under Renaming files and folders, below.) The new folder will be created in 
the active window (or on the desktop if no window is active). 

Renaming files and folders 

If you need to rename a file, folder, or any icon, you can use one of several 
techniques. 

1. Right-click the icon you want to rename and select Rename. 
2. The name of the icon is highlighted and a cursor is located at the end of the 

name. If you type a new name, you are replacing the whole name. To edit a 
few characters, use the left arrow to move the cursor through the text. You 
can then use simple text editing techniques to make your changes. 

3. Click outside the icon name to store the new name. 
Alternative: You can slowly double-click to rename the icon. Click the name 
and then click a second time, making sure that you wait between clicks. This 
action highlights the name and then allows you to edit or retype the filename. 
Deleting a file/folder 
A file, folder, or any object can be deleted using one of several methods. 

 Right-click the object and select Delete from the pop-up menu. 
 Drag the object to the Recycle Bin icon on the desktop. 
 You can select the object and press the [Delete] key. 

Note: Any deleted file is placed in the Recycle Bin. You must empty the Recycle 
Bin to permanently delete the file from the hard drive. To empty the Recycle Bin, 
place your mouse on the Recycle Bin icon and use your right mouse button to 
click. SelectEmpty Recycle Bin from the pop-up menu. 
Opening and closing different Windows 

Close tabs, windows, and Google Chrome 
You can close different tab pages in one browser window, multiple browser windows, 
or even Google Chrome itself. Learn how to use tabs in Chrome for mobile. 
Close tabs 

To close a tab, in the top right, click Close . Or use the keyboard shortcuts: 
 Windows and Linux: Press Ctrl+W 
 Mac: Press ⌘+W 
Close windows 
To close a window: 

 Close all tabs in the window. 
 In the corner of the window, click Close in the corner of the window. 
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 Windows or Linux: See the top right. 
 Mac: See the top left. 

You can also use the keyboard shortcuts to close a window: 
 Windows and Linux: Press Alt+F4 
 Mac: Press ⌘+Shift+W 
Recover a window or tab 
If you accidentally close a tab or window, you can recover it using the keyboard 
shortcut: 
 Windows and Linux: Press Ctrl+Shift+T 
 Mac: Press ⌘+Shift+T 
Close Google Chrome 
You can close Google Chrome entirely. 

1. Open the Chrome menu. 
 Windows and Linux: Click File on the top menu bar. 
 Mac: Click Chrome on the top menu bar. 
2. Close Google Chrome. 
 Windows and Linux: Click Exit. 

 Mac: Click Quit Google Chrome. 

You can also use the keyboard shortcut to close Google Chrome: 
 Windows and Linux: Press Ctrl+Shift+Q 
 Mac: Press ⌘+Q 
Force a webpage or application to close 

If a tab, window, or extension isn't working properly, you can use 
Chrome's task manager to force it to close. 

1. In the top right of Chrome, click the Menu . 
2. Click More Tools > Task Manager. 
3. Select the webpage, extension, or app you'd like to close. 
4. Click End process. 
(c) Windows setting 

Control Panels 

The Control Panel is a part of the Microsoft Windowsgraphical user interface which 
allows users to view and manipulate basic system settings and controls via applets, 
such as adding hardware, adding and removing software, controlling user accounts, 
and changing accessibility options. 
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Wall paper and Screen savers 

Wallpaper is the picture or background you see when you start your computer.  
 

 

 

 

 

 

 
A screen saver runs when your computer is idle. The length of time your computer 
needs to be idle before the screen saver starts is determined by the user.  

 

 
 

 

 

 

 
Both can be found through the control panel then display. Or you can right click on an 
empty spot on your desktop and select properties. 
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-Setting the data and sound 

Concepts of menu using help 

Using Tools, Windo, or Help menu items 
The most commonly used items from the Tools, Window and Help menus 
will be explained. A quiz will follow.  
Tools menu 

Window menu 
New Window - This opens another window with a copy of the active 
document. 
Arrange All - Displays all open files in the window. This makes 
dragging and dropping from one document to another much easier. 

Split - Splits the active window into panes. 
Open Document List - There is no need to drag windows to the side 
so you can see other documents open in Word. Come to the bottom 
of this window for a listing of all open documents. The active 
document has a check mark beside it. 

 
 
 
 
 
 

Spelling and Grammar - Choose either sub-menu and 
the same window opens. Questioned spelling is in red 
, grammar in green . 

Language/Thesaurus - Have you used the word "like" 
too many times? Highlight the word, select Thesaurus 
and get suggestions like similar and analogous. 

Word Count - Need to know how many words are in 
your document? Select Word Count and find out how 
many pages, words, characters, paragraphs, and lines. 

Auto Summarize - Exactly what it sounds like, Word 
summarizes the document, reducing the length of the 
document, keeping the meaning. 

Auto Correct - Word will automatically correct some 
things. If this feature is irritating to you, come here to 
change what is corrected. 

Customize- Opens the same window that you get by 
going to the View menu and selecting 
Toolbar/Customize. 

Options - Modify Word settings here. Modify print, 
editing, spelling and other options from this sub-
menu. 
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Help menu 
Microsoft Word Help - Open Word's Assistant and get a 
search box to type in. Word displays possible matches for 
you to read about. 

Contents and Index - See an index of all topics available in 
Word's Help documentation. 

Microsoft on the Web - That's right! It is exactly what it 
sounds like. Select a link and a Microsoft help page is 
opened in your browser. If you are not online, Word will 
make the connection and then display the page. 

About Microsoft Word - Not sure which version of Word 
you working with. Check here for version information and 
for the produce ID number. 

 

This quiz is available without the tables above  

1.You have dots appearing between words on the screen and nothing in this tutorial 

told you about what to do. Which menu do you select?  

2.You want to see two documents at the same time so you can drag text from one 

document to another. Which menu do you select?  

3.A word has been used too many times in your document and you need suggestions 

for another word to use. Which menu do you select?  

4.Grant application rules state that a maximum of 500 words are allowed and you 

don't want to count each word you typed. Which menu do you select?  

5.You have seven documents open at the same time and want to move from one to 

another. Which menu do you select?  

6.A button is missing from the formatting toolbar. You want to put it back in the bar. 

Which menu do you select?  

7.A friend wants to send you a document by Email and you are not sure which 

version of Word you are using. Which menu do you select?  

8.You want to open another window with the same document. You are about to make 

changes, but don't want to take a chance on losing the original document. Which 

menu do you select?  

9.You want to be  certain that all of your words are spelled correctly. Which menu do 

you select?  

10.Your document is too long to be included in a report and it needs to be 

summarized. Which menu do you select?  
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(d) Advanced Windows 

Using right button of the Mouse 

 

 

 

 

 

 

Creating short cuts 
To create a shortcut 
1. Open the location that contains the item to which you want to create a shortcut. 
2. Right-click the item, and then click Create Shortcut. The new shortcut appears in 

the same location as the original item. 
3. Drag the new shortcut to the desired location. 
Basic of windows setup 
Visit: https://www.youtube.com/watch?v=eEXwZYKkjPE 
To reinstall Windows Installer, follow these steps: 
1. Start your computer in Safe Mode. ... 
2. Click Start, click Run, type cmd, and then click OK. 
3. At the command prompt, type attrib -r -s -h %Windir%\System32\dllcache. ... 
4. At the command prompt, type CD %Windir%\System32, and then press ENTER. 
Notepad 
Notepad is a generic text editor included with all versions of Microsoft Windows that 

allows you to open and read plaintext files. If the file contains special formatting or is 

not a plaintext file, it will not be able to be read in Microsoft Notepad. In the image to 

the right, is a small example of what the Microsoft Notepad may look like while 

running. 

Note: If you need built-in features such as a spell checker, grammar checker, font 

sizes, multimedia (e.g. pictures), etc. you should be using a word processor and not an 

editor. 

 

 

 

https://www.youtube.com/watch?v=eEXwZYKkjPE
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How to open Windows Notepad 

Users who are using Microsoft Windows can run Microsoft Notepad (notepad.exe) by 

following the steps below. 
1. Click Start 
2. In the Run box or on the Windows Start Screen type "notepad" and press 

Enter.            or 
1. Click Start 
2. Click Programs and then Accessories 
3. Click the "Notepad" icon. 

How to create a text file using notepad 

Open Notepad and type your text you want in the file. Once done save the file by 

clicking File and then Save. When saving the file make sure the file is saved with a .txt 

extension.          or 

On the Windows Desktop or any folder right-click anywhere, from the menu 

select Newand then Text Document. After this has been done a file should appear 

named "New Text Document", double-click this file to open the text document 

or rename the file to the name of your choice and then open the file. 
Can you insert a picture in Notepad? 

No. Notepad is a plaintext editor and does not support pictures. If you want to insert 

pictures consider using Wordpad instead of Notepad. Keep in mind that once the file 

has been saved with a picture it must be saved as a .RTF file and not a .TXT file. 
Where is Notepad on my Apple Mac? 

The Apple Mac OS does not include Notepad, use their TextEdit program instead. 
Notepad alternatives 

Trying to create anything else other than a basic plain text file can be difficult in 

Notepad. If you are looking for a free alternative for Notepad we highly 

recommendNotepad++, which is an excellent free and open source alternative. 

Notepad++ supports syntax highlighting, regular expressions, autocomplete, and 

much more. 
Window Accessories 
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MS Windows has many accessories for day to day use and tools for maintaining 
computer in good shape. Some important accessories and tools available in Windows 
XP are : 
Important Accessories 

 
 
 

 

Magnifier: 

( Start button >> Programs >> Accessories >> Accessibility >> Magnifier ) 

A click on Magnifier opens a window on top or bottom of the screen in which the 
contents of the screen around the mouse pointer are magnified. User can set 
magnification level or invert colors. This utility is useful for readingsmall prints in 
some portion of a page comfortably for normal users and for working in general for 
users with poor eye sight. 
Narrater : 
( Start button >> Programs >> Accessories >> Accessibility >> Narrater ) 
It reads out the on screen text. This utility is useful if you prefer to listen than to read 
a long text from the screen. 
Network Connections : 
( Start button >> Programs >> Accessories >> Communication >> Network 
Connections ) 

Displays available Network and Internet Connections available on the computer. You 
can change settings of available connections by right click on a connection and 
selecting properties. You can also open wizard to create a new dial up or other 
connection by a click on 'Create a new connection'. The new connection wizard can 
also be opened directly by 

Start button >> Programs >> Accessories >> Communication >> New Connection 

Wizard  

Windows Media Player : 
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( Start button >> Programs >> Accessories >> Entertainment >> Windows Media 
Player ) 

You can play audio and video files by using Windows Media Player. You can choose 
different skins for the player from the available list or download more skins from 
Microsoft Windows site. 
Volume Control : 
 
 
 
 

( Start button >> Programs >> Accessories >> Entertainment >> Volume Control ) 

Enables to adjust master volume and balance of your audio speakers. You can set 
different volumes for different file formats wave and midi and also for music played 
from CD Rom. By default an icon of 'Volume Control' is also placed in 'System Tray' 
for easy access. Right click on the icon in Notification Area opens full volume control 
window and a left click opens a small volume controller from which you can control 
the master volume of audio speakers. The volume can also be controlled by the 
software of your sound card installed. 

 

Windows Calculator 

Calculator : 

 

 

 

 

 

 

 

 

( Start button >> Programs >> Accessories >> Entertainment >> Volume Control ) 

Window provides a simple calculator for doing arithmetic calculations. If you are 
required to use calculator frequently, you can create its icon on your desktop or in 
Quick Launch area by dragging the icon by holding the mouse on it from above location 
to your desired location for prompt and convenient access to this tool. 
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Command Prompt : 

( Start button >> Programs >> Accessories >> Calculator ) 
Enables use of DOS commands required for a program/application. 

Paint : 

 

 

 

 

 

 

 

 

( Start button >> Programs >> Accessories >> Paint ) 
Paint is a simple drawing tool and can be used for simple drawings using Lines, Curves, 
Rectangles, Circles etc. It can also be used to add text to images. It is not a very effective 
tool for editing pictures. 
Notepad : 
( Start button >> Programs >> Accessories >> Notepad ) 
Notepad creates and edits text and performs basic functions of a text editor without 
much formatting options. 
Wordpad : 
( Start button >> Programs >> Accessories >> Wordpad ) 
Wordpad is better text editor than Notepad as it provides more formatting options. 
Cut,copy and paste 

If you're looking to copy and paste text, left-click and a drag your mouse cursor over 
the portion of the document you wish to highlight. For folders and other items, 
simple left-click the item once or hold down the “CTRL” key before left-clicking 
multiple items 
3. WORD PROCESSING IN ENGLISH: MS WORD –Marks 20 
(a)  Word Processing Basic 

An introduction to MS WORD 
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What is Microsoft Word (MS Word)? MS Word is the most popularword 
processing software used today. A word processor is essentially a computerized 
version of the standard typewriter. However, the computer adds features typewriters 
never dreamed of having like spell check, the ability to save and store documents, copy 
and past functions, the ability to add images and shapes to documents, and many 
more. When attached to an email, electronic documents, created by MS Word can be 
delivered in seconds. Another benefit is that it helps the user to type faster and more 
accurate. 

What is MS Word Used For? This software is used to create, edit, and format 
written documents in the workplace, at school, and at home. Examples include 
personal and formal business letters, resumes, coversheets, and homework. 
Intermediate and advanced level knowledge of this software could lead to job 
opportunities since MS Word is used a lot in the workplace. 
Opening MS WORD Package 

Type "Word" into the box and click "Finish." Double-click the Word shortcut that 
appears on the desktop to launch Word. Open an MS Word file on your computer 
by double-clicking it. If you are asked to choose an application to open the file with, 
select "Microsoft Word." 
Step 1 
Click the Start button. Type "word" without quotation marks into the search box. Click 
"Microsoft Word 2010" in the list that appears. 
Step 2 
Click the Start button. Hover the mouse pointer over "All Programs." Scroll down to 
the Microsoft Office folder and click it. Select "Microsoft Word 2010." 
Step 3 
Press the Windows key and "R" on the keyboard at the same time to bring up the Run 
dialogue. Type "WinWord.exe" without quotation marks into the box. 
Step 4 
Right-click on an empty area of the Windows 7 desktop. Hover the mouse pointer over 
"New" in the menu that appears. Click "Shortcut." Type or copy and paste "C:\Program 
Files\Microsoft Office\Office14\WINWORD.EXE" into the box. Click "Next." Type 
"Word" into the box and click "Finish." Double-click the Word shortcut that appears 
on the desktop to launch Word. 
Step 5 
Open an MS Word file on your computer by double-clicking it. If you are asked to 
choose an application to open the file with, select "Microsoft Word." You may close the 
file you have opened if you do not want to use it now and open another one instead. 
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The Menu Bar 

Using Icon below menu bar 
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A thin, rectangular window containing dropdown menus, a menu bar is used in many 
computer programs. Its primary function is to house application or window-specific 
menus that provide an assortment of functions to the user. These functions include 
interactions like opening files, editing text, bringing up software-related help menus. 

Using the help 

Much like searching the research database for answers to your questions, you can use 
the help menu which searches a database for answers to your Word questions. To 
access the help menu, go to the Menu Bar and select Help > Microsoft Word Help. 
Access to Word's Help Resources will open on the right. Enter the keywords or phrase 
of the skill or information you are researching in the Search For: box. See diagram 
below. 
 

 

 

 

 

 

 

 

 

(b) Opening and Closing Documents 

Opening Documents – Save and Save As 

“New” command is use to open a new document. To open a “New” document click 
on “Office button” then click on “New” and lastly click on “Blank document” and 
then click on “Create” button as given below. 
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Open:- 
From “Open” command we can open saved files. For example we have saved a file by 
the name of“Microsoft word” and now we want to open it so firstly click on “Office 
button” and then click on“Open” and lastly select your file and click open and we 
can also open a file by the help of Shortcut key. To open a file by the help of shortcut 
key click “Ctrl+O” as given below. 
 

 

 

 

 

 

 

 
Save:- 

This command is use to save a document. To save a file click “Office button” then 
click “Save”command and “type the name” that in which name you want to save 
this file. For example I want to save a file by the name of “Microsoft notes” and then 
I click “Save”. The shortcut key for “Save”command is “Ctrl+S”. 
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Save As:- 

“Save As” command is use to save a file by two or more than two names. What is 
difference between“Save” and “Save As” command. “Save” command is use to save 
a document by only one name but In“Save As” command we can save a file by two or 
more than two names. For example we have already saved a file by the name 
of “Microsoft Word” and now we want to save it by two names or more than two 
names as given below. The shortcut key for “Save As” is “F12”. 

 

 

 

 

 

 

 

Page set up 

The parameters defined by the user that help determine how a printed page will 
appear. Those parameters can include everything from the size, margins, page 
orientation, or quality of print. The page setup dialog box is usually available 
from the File drop down menu. In the picture below, is an example of what the 
Page Setup dialog box may look like in Windows. 
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Alternative Page Setup screen 
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Printing Documents 

To print a document, your computer needs to be connected to a printer. Being able to 
print is not necessary in order to use Word, but if you want to send a letter in the post 
or print out a poster, you’ll need to have access to a printer. 
You’ll need: 

 A computer with Microsoft Word installed. 

 A printer set up and connected to your computer. 

Follow these step-by-step instructions to print a document from 
Microsoft Word 

Step 1: Open an existing Word document or start a new document and type your 
text. 

Step 2: Once you’ve completed your document and are ready to print, click Filein 
the top left-hand corner of your document. 

 

 

 

 

Alternatively, some versions of Word may have an Office button instead of a ‘File’ 
button – it’s a round Office icon in the top left-hand corner of the screen. Click on this 
if you have one 

 

 

 

 

 

 

 

 

Step 3: Move down and click Print in the menu. This will bring up the ‘Print’ dialogue 
box. 
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Step 4: Choose how many copies of your document you need 

 

 

 

 

 

 

 

 

  

 

 

 

Step 5: Depending on your printer options, you can choose other printing features 
such as whether you want to print all pages or only certain pages. You can also change 
the orientation of the print from portrait to landscape and tell your computer and 
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printer whether you’re printing on a certain size of paper. You’ll also see, on the right, 
a preview of your printed document will look like. 

Step 6: When you’re happy with your settings, click Print. The document will now 
start printing on your printer. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Display/Hiding paragraph marks and inter word space 

Step 1: 

click Officeicon               and then click Word Options in Word 2007; 

click Filetab                  and then click Options in Word 2010/2013. 

Step 2: click Display, in Always show these formatting marks on the 
screen section, check to show them in documents or you can check Show all 
formatting marks to show all formatting marks in document. 

 

 

 



COMPUTER LITERACY TEST 33 

 

 Yakub Koyyur,GHS Nada,Belthangady Taluk,D.K.-574214 Ph:9008983286 33 

 

 

 

 

 

 

 

 

 

Note: If you want to show or hide all formatting marks, you can click           under 
Home tab, or you can press shortcut Ctrl+* to switch showing or hiding. 

(c) Moving around in a document 

Scrolling the document – Scrolling by link/paragraph 

Fast scrolling and moving pages 

If you use Google Docs or Presentations and share your work with others, giving 

them a link directly to the part of your slideshow or paper you want them to see 

makes it easier for you to get the feedback you need and for them to find what you 

need them to read. Here's how to do it. 

In Google Docs, you'll need to create a bookmark at the paragraph you want to share 

first: 

1. Open your document and scroll down to the paragraph you want to link to. 

2. Click the Insert menu in Google Docs and select "Bookmark." 

3. You'll see a bookmark ribbon at the beginning of the paragraph, with links 

next to it for "Link" and "Remove." 

4. Right-click the "Link" to copy it to your clipboard, or click it to open it, then 

copy it from your browser's address bar. 

5. Email or IM the link to a friend! 
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(d) Using a document/Help Wizard 

 

 

 

 

 

 

 

 

 

 

 
(e) Text creation and manipulation 

Paragraph and Tab setting 

Another way to adjust the indents is to view the Paragraph settings. To view this 
window, double-click on the markers in the Ruler, click Format and 
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then Paragraph. You can also place the cursor in the paragraph, right-click with your 
mouse, and choseParagraph. 
s seen below in the Paragraph window, under the Indentation section, the left and 
right indent settings can be adjusted. You can also adjust the first line indent and 
hanging indent size under the Special option in the Indentation section. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

At the bottom of the Paragraph settings window, you can preview the look of the 
indent sizes you are setting and make changes accordingly until you get it the way 
you want. 

Text setting 

To change the style of the default font in Word 2002 or in Word 2003, follow these 
steps: 

1. If you do not have a document open, create a new document that is based on the 
Normal template.  
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To do this, click New on the File menu, and then click Blank Document in 
the New Document task pane. 

2. On the Format menu, click Font. 
3. Select the font, the point size, and any attributes that you want. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click Default. 
2. Click Yes when you receive the following message: 

Do you want to change the default font to font name? 
This change will affect all new documents based on the NORMAL template. 

3. On the File menu, hold the SHIFT key down, and then click Save All.  
 
Note If Word prompts you to save the new blank document, click Cancel. Word will 
not prompt you to save the changes to the Normal template unless the Prompt to 
save Normal template option is selected on the Savetab. To find this option, 
click Options on the Tools menu. 
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- Cut, Copy and Paste 

 

 

 

 

 

 

 

 

 

Font and size selection 

Bold, Italic and Underline 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



COMPUTER LITERACY TEST 38 

 

 Yakub Koyyur,GHS Nada,Belthangady Taluk,D.K.-574214 Ph:9008983286 38 

 

Alignment of text – center, Left, Right and Justify 

 

 

 

(f) Formating text: 
- Changing font, size and colour 
- Paragraph indenting 
- Bullets and numbering 
- Use of Tab and Tab setting 
- Changing Case 
Formatted text can draw the reader's attention to specific parts of a document 
and emphasize important information. In Word, you have several options for 
adjusting the font of your text, including size,color, and inserting 
special symbols. You can also adjust thealignment of the text to change how 
it is displayed on the page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(g) Handling multiple documents: 

- Opening and closing multiple documents 
- Cut, Copy and across the documents 
- Saving of clip boards 
-  
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(h) Table manipulation: 
- Concept of Table – Rows, Columns and cells 
- Draw table 
- Changing cell width and height 
- Alignment of text cell 
- Copying of cell 
- Delete/inserting of row or columns 
- Boarders of table 

Create a Table by Using the Table Menu 

1. Click where you want to create a table. 
2. On the Table menu, point to Insert, and then click Table. 
3. In the Insert Table dialog box, change Number of columns and Number of rows to 

the size that you want for your table, and then click OK. 
(i) Printing 

- Printing 
- Print preview 
- Print selected page 
- Mail merge 

4.SPREAD SHEET – MS EXCEL:                                         20 Marks 

 

 

 

 

 

 

 

 

(a) Elements of Electronic Spread Sheets – MS EXCEL 
- Application/usage of spread sheet 

A spreadsheet is an interactive computer applicationfor 
organization, analysis and storage of data in tabular 
form. Spreadsheets are developed as computerized simulations of 
paper accounting worksheets. The program operates on data entered in 
cells of a table. 
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- Opening of MS Excel 
- The Menu bar 
- Work Book and sheets 
- Creation of cells and addressing 
- Cell inputting 
- Edit features 

(b) Manipulation of cells 
- Enter text, numbers and dates 
- Inserting of cells, rows and columns 
- Formating of cells, rows and columns 
- Creating of tables 
- Cell height and moving cells 

(c) Use of formulas 
A formula is used to represent an expression, which, one entered into the 
cell, allows the spreadsheet to perform automatic calculations based on 
values in other cells and to display the result. Formulas may also contain 
references to other cells, expressions, or functions. 
A formula is an expression which calculates the value of a cell. Functions are 
predefined formulas and are already available in Excel 
- Using of basic formulas 
- Functions – Financial, Statistical, Date & Time, Maths & Trg 

and Logical 
(d) Data Manipulation: 

- Sorting 
- Filter 
- Subtotal 

(e) Window 
- Freez pans 
- Split 
- Hide 

(f) Charts 
- What is chart and its usage 

Charts are visual representations of worksheet data. Charts often makes it easier to 
understand the data in a worksheetbecause users can easily pick out patterns and 
trends illustrated in the chart that are otherwise difficult to see 

- Different types of chart – column, Bar, Line, pie chart etc 
- Creation of chart 
- Customization 

 



COMPUTER LITERACY TEST 41 

 

 Yakub Koyyur,GHS Nada,Belthangady Taluk,D.K.-574214 Ph:9008983286 41 

 

 

 

 

 

 

(g) Spread sheet for small accounting 
- Maintaining invoice/budget 
- Totaling of Various transactions 
- Maintaining daily and monthly sales report 
- Preparing monthly salary Bills 
- Preparing Statistical reports with charts 
-  

5. COMPUTER COMMUNICATION AND INTERNET:      10 Marks 

(a) Basic computer networks 

 

 

 

 

 

 

LAN 
A local-area network (LAN) is a computer network that spans a relatively small area. 
Most often, a LAN is confined to a single room, building or group of buildings, 
however, one LAN can be connected to other LANs over any distance via telephone 
lines and radio waves. 
Internet 
WAN 
A wide area network (WAN) is a geographically dispersed telecommun 
ications network. The term distinguishes a broader telecommunication structure from 
a local area network (LAN). A wide area network may be privately owned or rented, 
but the term usually connotes the inclusion of public (shared user) networks. An 
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intermediate form of network in terms of geography is a metropolitan area network 
(MAN). 
(b) Internet 
- Concept of Internet 
BASIC INTERNET CONCEPTS. The Internet is a global collection of computer 
networks that are linked together by devices called routers and use a common set of 
protocols for data transmission known as TCP/IP (transmission control protocol 
/Internet protocol). 
- Application Internet 
 
 
 
 
 
 
 
 

 (c)    Service on Internet 
- WWW and web sites 
A website, also written as web site, is a collection of related web pages, including 
multimedia content, typically identified with a common domain name, and published 
on at least one web server. 
- Communication and internet 
The World Wide Web, or the Internet, is a series of connected networks that connect 
computers across the world together. This network allows different kinds 
ofcommunication methods. Voice over IP, or VoIP, refers to programs like Skype 
that allow people to communicate using audio and video over the Internet. 
(d)  Web browsing software 
           - Internet Explorer 
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Netscape Communicator 
Netscape Communicator (or Netscape 4) is a discontinued Internet suite 
produced by Netscape Communications Corporation, and was the fourth major 
release in theNetscape line of browsers. 
 
 
 
 
 
 
 
 (e)  Surfing the Internet 
          - Giving URL address 
          - Search 
          - Moving around website 
          - Printing or saving portion of web pages 
          - Down loading 

    (f)  - Chatting on internet 

Online chat may refer to any kind of communication over theInternet that offers a 
real-time transmission of text messages from sender to receiver. Chat messages are 
generally short in order to enable other participants to respond quickly. 

E-MAIL:                                                                                          10 Marks 

(a) Basic of electronic mail 

 

 

 

 

 

 

What is an electronic mail 

E-mail can be distributed to lists of people as well as to individuals. A shared 
distribution list can be managed by using an e-mail reflector. Some mailing lists allow 
you to subscribe by sending a request to the mailing list administrator. A mailing list 
that is administered automatically is called a list server. 
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E – mail addressing 

Each email address is expressed in the form "name@domain" and is unique at that 
domain, as in for example "jane@twenty.net". The key to this elegant architecture is 
its simple structure, where each domain's associated mail server maintains the 
accounts for all users with email addresses at that domain. 

Mailbox – inbox and outbox 

A mailbox is the storage location of electronic mail messages that is found either on 
a remote server or downloaded to the user's hard drive. Software e-mail programs 
commonly divide the mailbox into separate folders, notably the inbox, outbox, sent 
items, and deleted items. 

(b) Using E-Mails 
- Viewing 
- Sending 
- Saving 
- Sending same and mail to various users 

(c) Document handling  
- Sending soft copy as attachment 

Part of the Printers glossary: A soft copy (sometimes spelled "softcopy") 
is an electronic copy of some type of data, such as a file viewed on a 
computer's display or transmitted as an e-mail attachment. Such material, 
when printed, is referred to as a hard copy  
- Enclosures to E- Mail 

Supporting materials/items/media. An attachment is a separate document 
that is sent in an electronic folder along with your email message. An 
attachment notation is used when something is stapled, clipped or 'attached' 
to the original letter. In contrast, an enclosure is included within 
the email message. 
- Sending portion of document as E – Mail 

- Open My Computer or Windows Explorer and move to the location of 
where your files are located. 

- Highlight and copy the picture you want to send. 
- Open a new e-mail or reply message, and then right-click in the body 

portion of the e-mail and select paste. 
 

 

 

mailto:jane@twenty.net
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6. POWER POINT:                                                            5Marks 

 

 

 

 

 

 

    (a)     Basics 
             - Difference between document and presentation 

1. A presentation file has a higher width than height (like the 4:3 or 16:9 aspect 
ratio of a presentation slide) 

2. A document file has a higher height than width (like a standard A4/8 ½ x 11 
document) 

             - Using power point 
             - Opening power point presentation 

Start PowerPoint and then click the File tab > Open. The usual Open file dialogue box 
that you may already be familiar with opens and you use this to locate your 
presentation. 

 
 
 
 
 
 
 
 
 
 
 
 

When you find your presentation, either double click it to open it, or select it and 
then click Open. The presentation will then open for you to either work on it or 
run it. 
The keyboard shortcut for opening a presentation the same as that for opening 
existing documents in other Microsoft Office programs:ctrl-o. 
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- Using Wizard of creating presentation 
To Use the AutoContent Wizard: 

1. Click Start. 
2. Choose Microsoft PowerPoint. 
3. When the PowerPoint dialog box appears, choose AutoContent Wizard. 
4. Click OK.  
(b)   Creation of Presentation 
        Title 
        Text creation 
        Font and sizes 
        Bullet and indenting 
        Moving to next slide 
(c)    Preparation of Slides 
        Selection type of slides 
        Importing text from documents 
        Moving to next slide 
The slide manager 
A slide master is the top slide in a hierarchy of slidesthat stores information about 
the theme and slide layouts of a presentation, including the background, color, fonts, 
effects, placeholder sizes, and positioning. Every presentation contains at least 
one slide master. 
(d)    Providing aesthetics 
         Slide Design 
         Background and text colours 
         Marking your own slide format 
         Footnootes and slide numbering 
 (e)    Slide manipulation and slide show 
 (f)    Presentation of slides 
         Using slide show 
         printing the slides and Handouts 
Slide sorter 
Slide Sorter view is a feature included in Microsoft PowerPoint software that allows 
the user to see all the slides in a presentation at one time. The slides appear in the 
task pane as small graphics that are arranged in rows and columns 
         Title sorter 

6. KNOWLEDGE OF KANNADA NUDI SOFTWARE  IN- 10Marks 

           Nudi is a computer program and font-encoding standard used for   

           managing and displaying the Kannada script. 
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The Karnataka government owns and makes the Nudi software available for 
free. It was developed by the Kannada Ganaka Parishat, a non-profit 
organisation. Most of the fonts included with Nudi can be used for dynamic font 
embedding purposes; however, since the fonts and software are available freely, 
they can be used in other situations as well, for example database management. 
It is a font-encoding based standard (i.e., it uses ASCII values to store glyphs). 
However, Nudi editor provides saving in Unicode and Nudi engine provides 
inputting data in Unicode provided the system provides support to Unicode and 
system has an opentype font. 

Nudi supports most of the windows based database systems like Access, Oracle, 
SQL, DB2 etc., It also supports MySQL. 

       (a) -Word Processing 
        (b)  - Spread Sheet 
        (c)  - Power  Point Presentation and 
        (d)  - Internet and communication 
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